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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and
get a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience
This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

e Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.

e Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

e The 10 I/Os Family PLCs are Open Type Controllers. It is required that you install the 10
I/0s PLC in a housing, cabinet, or electric control room. Entry to the housing, cabinet,



or electric control room should be limited to authorized personnel. Failure to follow
these installation requirements could result in severe personal injury and/or property
damage. Always follow these requirements when 10 1/Os family PLCs.

In case of installation or maintenance of the 10 I/Os please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.
Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille 10 1/Os sont des contrdleurs de type ouvert. Il est
nécessaire d'installer I'automate 10 I/Os dans un boitier, une armoire ou une salle de
contrdle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille 10 1/Os.

En cas d'installation ou de maintenance du 10 I/Os, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmospheére
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.



Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e OQOutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.



Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.



Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification - External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions because of improper operation of
the system and/or failure to dispose of components safely and correctly.



Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1. 10 I/0s Digital Module: General Features

COMPACT PLC 10 I/0Os DIGITAL MODULE CPU
ESP32

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24 vdc
Rated Power 30W
| Max. 1,5A
Size 100x45x115
Clock Speed External: 240 MHz Internal: 8 MHz
External Flash Memory 4MB
SRAM 4 MB
PSRAM 2 MB
Communications USB - RS485 — ETH — WiFi — BLE MAX487CSA - W5500
TOTAL Input points 10
TOTAL Output points 10
3.3t0 24 Vdc
Freq: 10 Hz

Digital Input 10bit
3,3-24 Vdc
220 VAc (3 — 48 Vdc)

Input Impedance: 27K
Separated PCB ground
Rated Voltage: 10Vac

220 Vac (3 — 48 Vdc)
Input Impedance: 54K
Rated Voltage: 220 Vac

I min: 2 to 12 mA
Opto-isolation
Rated Voltage: 24 Vdc

Antipolarity + Overcurrent
(220 Ac)

Digital Isolated Output
(24Vcce)

24 Vdc (23,2 Vdc)
I max: 300 mA
Optro-isolation
Rated Voltage: 24Vdc

Imax 24Vdc: 1 A

Expandability

USB — RS485 — ETH — WiFi — BLE

Reference

IS. 013002000100
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2. Technical Specifications

2.1  General Specifications:
Power supply —
voltage DC power supply 12 to 24Vdc
Operating —
voltage range DC power supply 11.4t025.4vdc ===
Power DC power supply 30 VAC max.

consumption

External
power supply

Insulation resistance

Power supply voltage 24Vde ===

Power supply output

. 300 mA
capacity

terminal.

20MQ min. at 500Vdc between the AC terminals and the protective ground

Dielectric strength

2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA
max. Between all the external AC terminals and the protective earth

terminal.
Shock resistance 80m/s? in the X, Y and Z direction 2 times each.
Ambient temperature (operating) 0° to 60°C
Ambient humidity (operating) 10% to 90% (no condensation)
Ambient environment (operating) With no corrosive gas
Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.

2.2 Performance Specification:

Board

ESP32 DevKit C (3,3V)

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ESP32
External Flash Memory 4MB
Program capacity (SRAM) 4MB
PSRAM 2MB
Clock Speed 8MHz

11
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2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the PLC 10 I/Os Digital

Module CPU ESP32:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : . .
I —— Graphical symbols 5031 / Direct Indicates that the equipment IS
B B = suitable for direct current only;
for use on Current . ; .
: to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols 5032 / Alternatin suitable for alternating current
Y for use on 9 only; to identify relevant
; Current .
equipment terminals
IEC 60417 /
raphical symbol To identify th ntrol
© a?o:CSS:)gnbo ) 5130/ Pulse w%ilgﬁ at Igjsg izost;?tebdy
; General '
equipment
IEC 60417 / To identify an earth (ground)
‘ Graphical symbols terminal in cases where
for use on 50gréliegth, neither the symbol 5018 nor
equipment 5019 is explicily required.
IEC 60417 / . . .
Graphical symbols To identify the swﬁch by
for use on 5115/ Slgnal lamp means of which the signal
; lamp(s) is (are) switched on or
equipment

off.

C€

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking licabl .
93/42/EEC applicable Eurqpean Union
regulations
ISO 7000/ . .
Graphical symbols Indlcates_a p(_)tentlal_ly _
for use on 0434B / hazardous situation which, if
equioment Warning symbol not avoided, could result in
quip death or serious injury
ISO 7000/
Grap;(f;;cies%rgbols 5036 / Dangerous To indicate hazards arising
equipment Voltage from dangerous voltages

12




3. Precautions

Read this manual before attempting to use the 10 I/Os Digital Module CPU ESP32 and follow
its descriptions for reference during operation.

3.1 ESP32 Board

This version of 10 I/Os Digital Module PLCs include ESP32 Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate 10 I/Os Digital Module according to the performance specifications
described in this manual.

Before using 10 1/Os Digital Module CPU ESP32 under different conditions from what has been
specified in this manual or integrating 10 I/Os Digital Module CPU ESP32 to nuclear control
systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of 10 1/Os Digital Module are sufficient for the systems, machines, and
equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operating the 10 1/Os
Digital Module.

13



4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Furthermore, Industrial Shields provides boards for programming the PLCs much easier.
Basically, it is no needed to define the pins and if that pins are inputs or outputs. Everything is
set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings Networl:

Sketrhbook: lacation:

C:\Users\Albert\Documents\Arduino Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 > %  (requires restart of Arduing)

Show verbose output during compilation upload
Compiler warnings: Mone

[ pisplay line numbers

[CJEnable Code Folding

Verify code after upload

[Juse external editor

Check for updates on startup

Update sketch files to new extension on save (pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLS! )'vttp://‘apps‘mdusma\sh\a\ds.cnmfma\nfardu\nn/hnar’ds/pad'aqe_\ndusn'\alshla\ds_mde ﬁ

Mare preferences can be edited directly in the file
C:\Users\AlbertiAppData\ocal\Arduino15\preferences. it
(edit only when Arduino is not running)

Ok Cancel

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

If you already have an URL inserted, input an “,” between both URLs.

3. Press OK to save the changes.
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4. Go to: Tools -> Board: ... -> Boards Manager

© sketch_jan13a Arduino 1.8.13 - [} X

Archivo Editar Programa Herramientas Ayuda

Auto Formato Ctrl+T
Archivo de programa.
Reparar codificacion & Recargar.

sketch_jan13a

. Administrar Bibliotecas. Ctrl+Maytis+1
void setup(  wonitorSeri Ctrl+Maytis+M
// put yq SeralPlotter Ctri+Mayls:l  hnce =

WiFi101 / WiFININA Firmware Updater

} Placa: "Ardbox family” ) Gestor de tarjetas.
Model: "Ardbox Relay HF+ w/ HW RS-485" ' Arduino AVR Boards >
Puerto ESP32 Arduino >
void loop ()  Obténinformacién de la placa Industrial Shields boards >

Industrial Shields ESP32 modules

// vt s programador i

Quemar Bootloader

5. Search for industrialshields.

@ Gestor de tarjetas X
Tipo Todos ~ | industrialshields
industrialshields ~

versién 1.1.29 INSTALLED

Tarjetas incluidas en éste paquete

ARDBOX family, ARDBOX DALI family, ARDBOX GPRS family, ARDBOX LoRa family, ARDBOX WiFi/8T family, M-Duino family, M-Duino DALI family,
M-Duino GPRS family, M-Duino LoRa family, M-Duino WiFi/BT family, Spartan family.

Online Help.

More Info

industrialshields-esp32

versién 1.0.2 INSTALLED
Tarjetas incluidas en éste paquete
WiFi/BT module.

Online Help.

More Info

Seleccione version Instalar Eliminar

v

Cerrar

6. Click install industrialshields-esp32 (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

@ sketch_jan13a Arduine 1.8.13 - m} x ‘

Archivo Editar Programa Hemamientas Ayuda

Auto Formato Crrl+T
Archivo de programa.

Reparar codificacion & Recargar.

sketch_jan13a

Administrar Bibliotecas.. Ctri+Mayus+| A
Monitor Serie Ctri+Mayas+M
} Serial Plotter Ctrl+Mayis+L

WIiFi101 / WiFiNINA Firmware Updater

] p () Placa: “10 105 PLC Family” 3 Gestor de tarjetas..
// put y Model: “10 105 PLC Digital® 3 Arduino AVR Boards >
Puert ESP32 Arduino >
Obtén informacién de la placa Industrial Shields boards >
} | Shields ESP32 *  WiFi module v
Programador Pl

- :
Quemar Bootloader 10 105 PLC Family



Once it is selected the 10 |0s PLC Family in Industrial Shields ESP32 Family, an extra option will
appear on Tools:

@ sketch_jan13a Arduine 1.8.13 — O ot

Archivo Editar Programa Herramientas Ayuda

Auto Formato Ctrl+T
Archivo de programa.

sketch_jan13a Reparar codificacion & Recargar.

Administrar Bibliotecas... Ctrl+Mayus+|

Monitor Serie Ctrl+Mayas+M
Serial Plotter Ctrl+Mayls+L

WiFi101 / WiFiNINA Firmware Updater

Placa: “10 105 PLC Family™ >

// put wyd  Modek 1010 PLC Digital" 3[® 10105 PLC Digital " :
Puert 10108 PLC Relay
Obtén informacién de la placa

Programador 3
Quemar Bootloader

10 105 PLC Family en COM23

There, it can be selected the exact model for every family. In this case 10 10s PLC Digital.

https://www.industrialshields.com/es ES/blog/arduino-industrial-1/post/issues-while-connecting-
the-wifi-module-on-industrial-plc-177

Install the following driver depending on the operating system you use in order to work
comfortably with the ESP32-based PLC.

Also, there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5. How to connect PLC ESP32 to PC

Connect USB port from PLC to PC.

NOTE:

PLC 10 I/Os Family uses micro USB cable.

Open Arduino IDE interface:
Select ESP32 Arduino boards -> DOIT ESP32 DEVKIT V1
Select correct port.

Cuteshiftel
CurlsShifteM
Curfeshiftel

Programmer: “AVRISP miir
Bum Bootioader

17



6. How to connect PLC to power supply

- 101/0s Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[ vomensurru]
—b GHND I

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIN Rail:

-12vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,
the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

18



7. 10 1/0s Digital Module pinout:

7.1  Left Zone Connections
= £
=) o
o o <
0 o
o= £ 35
= c 3 c
o 2
20 < T
Q0.9 G13 Digital Output
Qo0.8 G12 | Digital Output
Q0.7 G14 Digital Output
Q0.6 G27 | Digital Output
Q0.5 G26 Digital Output
Q04 G25 Digital Output
Q0.3 G32 Digital Output
Q0.2 G15 Digital Output
Q0.1 G2 Digital Output
Q0.0 G4 Digital Output

Output Pins

Output Pins

Power supply connectors
(12 to 24Vdc / GND)
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Right Zone Connections

7.2

—_ c

N I B

o
8 | § g
—_ C S c
o = S
— O < [y
10.9 G13 Digital Input
10.8 G12 Digital Input
10.7 G14 Digital Input
10.6 G27 Digital Input
10.5 G26 Digital Input
GNDCOM2 - Ground
10.4 G25 Digital Input
10.3 G32 Digital Input
10.2 G15 Digital Input
10.1 G2 Digital Input
10.0 G4 Digital Input
GNDCOM1 - Ground

106
10.5
GNDCOM 1

Input Pins

Common GND

Input Pins

Common GND
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7.3  Top Zone Connections

RS485
O
+ ON®)
Sl<bzz L
=
—— L 'y
I I:
-
I i :
GND RS485 4 |\ MUST NOT BE MICRO ETHERNET  POWER
pins (@) CONNECTED USB

NOTE: In case you need to activate the reset button, it can be found by opening the top cover
and accessing the white reset button of the ESP32 board integrated inside de enclosure.

NOTE: The LEDs positioned at the top of the PLC, which go from led 0 to 9 refer to both inputs
and outputs.

For example, if you are using input 10.9, LED 9 on the top cover of the PLC will indicate the
signal status of this input.

If output Q0.9 is being used, LED 9 on the upper cover of the PLC will indicate the status of the
signal of this output.

An input and an output with the same nomenclature can never work at the same time (see
jumper configuration on section 7).

21



8. Jumper configuration

8.1  General jumper configuration

The 10 I/Os Digital Module provide 10 digital pins that can act as both input and output. However, they
can only be working as one option at a time, so if their function is wished to be changed the jumpers
must be adjusted. The board is divided in four zones for controlling the I/Os pins, the GND and the 1/Os
voltages. Also, the 1/Os pins are divided in two blocks (0.9 to 0.5 and 0.4 to 0.0) that must be supplied
with the same voltage. In order to configure the pins properly, all the zones of the same pin must be set
correctly following the succeeding tables.

Warning!

If a pin is supplied with AC voltage, the entire block must be supplied with the same
voltage type. In the same way, if a pin is supplied with DC voltage, the entire block
must be supplied with DC voltage.

LEFT RIGHT

N O I O

1 2 3 1

IN - OouT IN - ouT

JUMPER ZONE 2

External GND Board GND

- o

1 2 3 1 3

JUMPER ZONE 3

WITHOUT WITH
230V 33-24V

This jumper zone makes the selection between using the pins as Inputs
or Outputs. There is a Jumper Zone 1 with three pins on each side of
the board. In the case of using the pins as Inputs, the jumper must be
connected on the pins 1 and 2. Otherwise, if the pin is wished to work
as an Output, connect it on the pins 2 and 3. Both zones must be
connected on the same way in order to work properly. See an example
on the section 8.2.

The Jumper Zone 2 is for choosing between the board ground and an
external one. If the Board GND is chosen using the pins 2 and 3, the pin
will work using the common ground of the device. In the case of using
and external ground, set the jumper on the left side connecting it to
the pins 1 and 2. See an example on the section 8.2.

These jumpers have to be set depending on the alimentation that the
circuit is supplied with. If a power supply voltage of between 3V - 24V
is being used, the switch must be connected as the Jumper Zone 3
photo. In the case of a 230 V power supply then the jumper must not
be connected. See an example on the section 8.2.
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& Warning!

Outputs: if the pin is working as output, its jumper of Zone 3 must be
connected as the 3.3 — 24 V option.

Inputs: if the pin is working as input, DO NOT connect the jumper if you are
using a power supply voltage of 230V as it will damage the device and could

burn it.

JUMPER ZONE 4

5V

24V

Mo o

3 1

This jumper zone makes the choosing between a 5V and 24 V. The 24V
option will be used in the case of using the pins as output as it will
provides the same voltage as the input voltage of the PLC, while the 5V
option will be reserved for the case of working as an input. Set the
jumper on the 1st and 2nd position for the 5 V choice or hte 2nd and
3rd pin for the 24V option. See an example on the section 8.2.
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ZONE 3 ZONE 2

ZONE 2
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8.2  1/0s Configuration examples
Input mode

Low voltage
This is an exemple to configure 0.9 as an input with the 3.3-24V current range.

0~
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o
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High voltage
This is an exemple to configure 0.9 as an input with the 230V current range.

ZONE 2

ZONE 3

DISCONNECT

__m DO NOT

00
o0
(ol
o0
OO0
o0
00
00
OO

ZONE 2
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Output mode

Low voltage
This is an exemple to configure 0.9 as an output with the 3.3-24V current range.
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9. I/0s Communications

9.1 RS485

The RS-485 is a half-duplex serial communication. The 10 I/Os PLC uses the MAX841CSA for the
RS-485 communication. In the following photo you can see the internal schematic of the PLC of
the connection between ESP32 pins, the RS-485 chip and its outputs.

10 I/0s PLC
RX
DE ' ™
TX -
MAX481CSA | 5
N J

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

9.2 Ethernet

10 I/Os Ethernet port controller is based on w5500 IC, which is the IC compatible with Arduino
Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the 10 I/Os.
In the 10 1/Os, W5500 IC communicates to the ESP32 board via SPI bus.

9.3 WiFi&BLE

The WiFi and Bluetooth integrated module consists in a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
loT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (loT) applications.
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General Specifications:

Wi-Fi

e 802.11b/g/n

e 802.11 n (2.4 GHz), up to 150 Mbps
Bluetooth

e Bluetooth 4.2 BR/EDR BLE dual mode controller
e +12 dBm transmitting power
e NZIF receiver with -97 dBm BLE sensitivity
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10. Typical Connections

—
o.rl-- ST
= i
Mi | 04
3.3V - 24V 10.0 i D
1230 GND GND1 (R 18 _I___l_ 0o
GND POWER
12124V ——
Downiload the MDUWD LAYOUT:

Froe warw ndusinalshesids cosn

GND
12/24V

Signal
Qutput

3.3-24v
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11. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/6-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/6-G-2,5THT & MCO0,5/5-G-2,5THT

Connection details:

Article reference MC 0,5/6-G-2,5 THT
Height 8,1Imm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference M1,5/ 6-G-
3,81
Height [h] 10.65mm
Pitch 3.81mm
Overall height (height 7.25mm

without welding pin)

Article reference IMC 1,5/ 6- ST-3,81

Lenght [I] 18.45mm
Width [w] 23.65mm
Height [h] 11.1mm
Pitch 3.81mm
Overall height 11.1mm
(height without

welding pin)



https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1

12. 101/0s Family Dimensions:

|
45mm width \/—j

129
114

- DIN rail mounting:

Profilato o cappello TH 35-7,5 Prcfilato a cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
15 8,
753
R 1004
15°
u ROS
—— 3%=03 k08
o
F
= e 1004
v Sezione A/ Section A -
0.3 o o~ 2.2 min.fino/To 2,5 mox
S| e
+
I Sezione A / Sedtion A
CARATTERISTICHE METODO ~ UNA'  BLEND FEATURES TEST UNITS  BLEND
DI MISURA _PU/ABS METHOD PUABS
Mecconiche R ione gl KSTHDE3  MPo 68 Mechanicol fest - Resistonce o tensil sess f vied ASTMDE38 MRy 8
Resi nitug ISTIDB38  MPo %8 Tenglostength ASTMD638 MR %
Alymometto o ot KT8 % 5 Utimonte do ASTIDE38 % 59
Mool in fesione KTADT0  WPo 2894 Pleing modulvs ASTADTS0 MR 8%
Provo [20d con intoglio 150180714 Xyni' 55 tod st noiched 1018014 Xiim' 55
Termiche Temp. di pmmolimento Viot, metdo B ASTM 01525 °C 114 Thermal fest Vit sodte methodB  ASTADISIS 114
Temperoe Ricto 1 81 MPy K064 °C 97 Reheting temperatue 1,81 WPg ASTMD848  °C 9
Fisiche Peso gpadfin KSTDT gfand V] Physical test  Spucc guviy ASTRDTS2  gy/and 121
Riti nello stompo KUADYSS % 0404 Mould shrnkoge ASTMD9SS % 0406
el Flow Index 260°C - 98N KSTMDIZE  gd10° 111 el Flow Index 260°C - 96N ASTMDIZ8 10 1l
Comportamento Aukesinguerea (mm di pesor) s - V-0(08) Flome test  Soff atinguisher hidness in i) e} - V008
allo fiomma _Fi Incardescen 32 mm 69521 °C 960 Inndestents theod 32 mm 169521 °C 960
Italtronic si riserva il diitto di modificore il moteriole con cui realizzo i propri prodotti Italtvonic con operate ony change of the moterials without being obliged to forewarn.
senzo obbligo di preawiiso.
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13.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the 10 1/0Os DIGITAL MODULE from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
10 I/Os Digital Module. When configuring the layout of the 10 I/Os Digital Module inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Also consider the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and high
energy, rapidly switched DC wiring.
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Provide adequate clearance for cooling and wiring 10 |I/Os Digital Module. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
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- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to lose parts or wires and
cause malfunctions. Excessive tightening can damage the screws and / or the module,
with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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